ACROBAT PROFESSIONAL ACCESSIBILITY GUIDE



LABELING MAIN HEADINGS AND SUBHEADINGS

IN THE READING ORDER

By using the Reading Order options in Acrobat, you identify the parts of your
manuscript. This helps in assuring proper formatting for all scenarios. Importantly, it also
is key to providing labels that can be used by screenreaders to properly interpret the parts
of your document. You should identify the main headings and each subheading as distinct
from the rest of your text. This guide will help you through this process. Know that if you
are working from Microsoft Word, our template already has the styles set up for you,
eliminating some of the excess work. We strongly suggest using it to format your
manuscript properly. Please see the Microsoft Word Accessibility Guide for instructions
for labeling main headings and subheadings in Word. If you follow those steps, you do
not need to repeat the process in Acrobat. This step is only necessary for documents that

were not labeled in Word.



Begin by clicking the Tools tab at the top of the page. You can see its location marked
with a red arrow below.
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From there, scroll down until you see the Accessibility option. Click this icon (circled
below).
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This brings up the accessibility options of the left side of your screen. Click on Reading
Order (circled below).
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This brings up the pop-up box seen below. You can drag and move this box around your
screen as necessary. Even though the text is grayed out, you can see the options you have
for labeling text. We are concerned with main headings (labeled as Heading 1), and
subheadings (labeled as Headings 2-6). If you have more than five levels of subheadings,
the rest will be labeled as text. Figures and tables should also be labeled; those will be
discussed in more depth in a subsequent section. Everything that is not one of these

options should be labeled as Text/Paragraph for our purposes.
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Here is an example of what a page that is appropriately labeled will look like. H1 for the
main heading, P for paragraph text, H2 for a 1% level subheading, H3 for a 2" level
subheading, H4 for a 3" level subheading, H5 for a 4™ level subheading, H6 for a 51

level subheading, and P for 6™ level subheadings and beyond.

CHAPTER1

CHAPTER TITLE GOES HERE
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You may skip levels if you prefer a different appearance scheme. as long as
you skip them in order. For instance, you can start with the 3™ level subheading but

then you have to move to one of the lower subheading levels for your next level. You

have to make these same choices for every chapter.




If you need to label something in your document, first move the pop up box out of the
way. Then, click and drag forming a box of the text you wish to label. You can see that
the main heading on this page is being selected.
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You may skip levels if you prefer a different appearance scheme, as long as
you skip them in order. For instance, you can start with the 3™ level subheading but
then you have to move to one of the lower subheading levels for your next level. You

have to make these same choices for every chapter.

The formerly grayed out text now becomes selectable options. Choose the appropriate
label and click it. In this example, H1 was chosen. The highlighted text may look like this
with pink boxes around each letter or it may surround each line. Either way is acceptable.

Continue labeling the parts of your document until you are satisfied that you have
properly identified all main headings and subheadings.



LABELING FIGURES AND TABLES AND

PROVIDING ALTERNATE TEXT

You will also need to identify your figures and tables using the Reading Order
options if you did not label them in Microsoft Word. Follow the steps in the previous
section to pull up the Reading Order pop up box. You also need to add alternate text to

your figures and tables if you did not do so in Microsoft Word.



If you have a figure that is not labeled as a figure, click and draw a box around the figure.
Select Figure from the Reading Order menu (circled below). This will place a large X
across the figure. The caption should be labeled Text/Paragraph, not Figure Caption. The
Figure Caption option is more advanced than our current needs and requires additional
steps in Acrobat. You can also see that this figure already has alternate text added. It is
the words you see displayed in the black text box over the figure.
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If you need to add alternate text, right click on the figure. From the menu that is now
displayed, select Edit Alternate Text. The red arrow is pointing at the Edit Alternate Text

option
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This will bring up a pop up box for you to enter your alternate text. Type your description
in the box and click OK when you are finished.
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If you need to label a table, click and drag to draw a box around the table. Label the table
itself as Table. This places an X over the table. The table title and any notes at the bottom
should be labeled Text/Paragraph. The Cell option is more advanced than our current
needs; do not label individual cells. Note that you can also tell that this table has already
had alternate text added. It is the words you see displayed in the black text box over the
table.

: Page numbers in the preliminary pages appear centered on the bottom of the page in Tower case Roman numerals. This differs

age numbers in the text. which aj on the top right of the page and use Arabic numerals.




If you need to add alternate text, right click on the table. From the menu that is now
displayed, select Edit Table Summary (shown by the red arrow).

Lprle 2.T Order of prelimmary pages. indicafing which are mandatory and where page numbers should be included.

|
Tounted

~~._ Vv Show reading order panel

Show page content groups

+ Display like elements in a single box
+/ Show table cells

v Show tables and figures

Run Form Field Recognition

Table Editor
Edit Table Summary

Clear page structure

: Page numbers in the preliminary pages appear centered on the bottom of the page in lower case Foman numerals. This differs
rom page numbers in the text, which appear on the top right of the page and use Arabic numerals.

This will bring up a pop up box for you to enter your alternate text. Type your description

in the box and click OK when you are finished.
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Table 2.1 lists the different types of pages possibly
located in a manuscript and then identifies if the
section is required, counted in the total pagination,

and how the page numbers should appear on that
saction, if at all.




ADDING BOOKMARKS

Main headings and subheadings should be made into clickable links. If you used
the Styles pane to label your main headings and subheadings in Microsoft Word, the
bookmarks should be automatically created. If you used our template, you may opt to add
in a bookmark for the Table of Contents; the rest of the bookmarks should have been
automatically created. If you do not have bookmarks or you are missing some, follow

these steps to add them to the PDF.
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Access the bookmarks option by clicking the ribbon icon on the left side of your PDF.
The red arrow below is pointing at the ribbon icon.
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If you have no bookmarks, the space that shows up will be blank. If you have existing
bookmarks, you will see them here. Notice that bookmarks are nested. The main headings
display in the outermost layer. Any subheadings go beneath the main heading. This
repeats for each level of subheading. You can see here that Chapters 1 and 2 have nested
subheadings by the > image next to the bookmark. Clicking on > will bring up the
bookmarks beneath the main heading.
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If you need to add a bookmark, position your page to the spot you’d like to add the link
to. In this example, the main heading ABSTRACT needs to be added. The heading is
positioned at the top of the screen. This is the exact spot readers will be taken to when
they click the bookmark ABSTRACT. When you have moved the page to the desired
spot, click on the icon of the ribbon with a plus symbol (circled below). This adds the
bookmark. You can type the title into the text box that appears. Another method is to
highlight the text (as seen in the example) before clicking the icon to add a bookmark.
This will copy the text automatically. Important: Make sure you hit return and are no
longer in the bookmark text box before you begin scrolling through the text again. This
may result in the bookmark being added to the incorrect spot.
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above. It may be no more than 350 words in length

You can see in this example the nesting of several layers of subheadings. If you need to
nest a subheading, click and hold onto the bookmark. Drag it to show it positioned
beneath the desired main heading/subheading.
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FILLING OUT THE DOCUMENT PROPERTIES

The document properties are metadata that helps to properly classify your

manuscript. Follow these steps to add this information to your PDF.



Begin by choosing the File menu. This is located in the menu bar at the top of your

screen, outside of the PDF. You can see the file menu marked by the red arrow below.
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Choose Properties from the File menu options. This option is marked by the red arrow
below.
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Make sure you are on the Description tab at the top of the screen. If you are on another
tab, click Description to get to the form fields you need to fill out. The Description tab is
circled below. Here, fill out the Title, Author, and Subject fields. In the title field, type
the exact name of your manuscript. In the Author field, type your full name as it appears
on your title page. In the subject field, type in the degree you are receiving. For most
students, this will be the name of your department. If you degree is different from your
department, type the degree name as it appears on your title page after the word “in.” The
Keywords field is optional. If you would like to fill out the Keywords, type in searchable
words and terms you would like to be associated with your manuscript. Keywords should

be separated by semicolons; do not use commas to separate keywords.

Document Properties

Description Security Fonts Initial View Custom Advanced

Description

File: handbook-2022.pdf

Title: Thesis Office Handbook

Author:  University of Utah

Subject:

Keywords:

Created: 7/26/22, 1:02:28 AM Additional Metadata...
Modified: 8/23/22, 11:10:14 AM

Application: Microsoft Word

Advanced

PDF Producer:
PDF Version:
Location:

File Size:
Page Size:
Tagged PDF:

Help

1.7 (Acrobat 8.x)

|Usersfericka/Desktop/

2.77 MB (2,907,299 Bytes)

8.50 x 11.00 in Number of Pages: 95
Yes Fast Web View:  Yes

Cancel



EMBEDDING THE FONTS

Embedding the fonts is essential for preserving the formatting of your manuscript.
This makes it so that readers with different programs on different devices will see your
manuscript exactly as you intended. All manuscripts should have the fonts embedded

prior to uploading to ProQuest.
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Begin by clicking the Tools tab at the top of the page. You can see its location marked
with a red arrow below.
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From there, scroll down until you see the Print Production option. Click this icon (circled
below).
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A menu will now be displayed on the right side of the PDF. From this menu, click on the
Preflight option, as shown by the red arrow.
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Save as PDF/X
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A new menu will pop up on the screen. Click on the small wrench icon indicated by the

red arrow below.
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v Digital printing and online publishing
j@ Digital printing (B/W) Edit... '3 -

Optimizes the current PDF document for digital printing. Converts
all colors - including spot colors - to grayscale.

2 Digital printing (color)

b PDF analysis

»- PDF fixups

» PDFjA

» PDF[UA

» PDF/X

b Prepress

» Further Options p Analyze \w Analyze and fix
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The options in this menu are separated by categories. In the Document category (circled
below), select the option to Embed fonts (even if text is invisible). To do so, simply click
on the line with this text (underlined below). It will bring up a larger description of what
this accomplishes. When you have selected this option, click the wrench/Fix button at the

bottom of the menu. This option is displayed with a red arrow below.
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Default - | WL pl

2 Force blend color space to sSRGB

;-3 Merge spot coelor name if appearance is identical
2 Set black text to overprint

= Set white text to knock out

( ¥ Document

- 2ss all uncompressed objects using lossless ZIP compressio
2 Convert fonts to outlines

@ J& Embad fonts

LJJ Embed fonts (even if text is invisible) Edit... '3 -

If a PDF uses fonts which are not embedded into the PDF file they

are embedded. This fixup embeds fonts even if they are only used

for text which is invisible (text rendering mode 3). It is required that

the respective fonts are present in the system's font folders. Some

fonts may have a flag indicating that their license does not allow

embedding. In this case the fonts are not embedded into the POF.
2 Embed missing fonts

» Further Options p Fix
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This prompts you to save a new version of your PDF. Saving the file as a different name
allows you to make additional edits if the embedding process alters some of the fonts.
Type the name you would like for the file and then click Save. In most ordinary
circumstances, this will not be the case. If your manuscript contains a lot of symbols, it is
wise for you to review the PDF after you have finished embedding the fonts to check for
any distortions.

Save as PDF
Save As: | handbook-2022
Tag
== Desktop B -
Format: Adobe PDF Files Kl

After saving the file, the embedding process will begin. You will see a pop up box that
tracks the embedding. You will see the program working its way through all of the pages.
When it is finished, the pop up box will convert to a summary of the embedding. At this
point, you can close out of the box. The embedding is complete. If you make any changes
directly to the PDF afterward, you will need to repeat this process. Embedding the fonts
should be the last step you take to prepare your manuscript.
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Preflight profile "Embed fonts (even if text is invisible)" did not find any
J 8rrors or warnings:

'J Pages 1- 95 from "handbook-2022 pdf"

v 2% Embed fonts {even if text is invisible)
> Embed fonts (even if text is invisible) (5 objects)
» 1IE overview

¥ JO Preflight information

Ok Show in Snap ) Embed Audit Trail... ||| Create Report...
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